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1. Introduction

1.1 Purpose

The CY3265-RGB Evaluation Kit demonstrates the ability of an EZ-Color controller to control three

primary, high brightness LEDs and create accurate, mixed-color output. The three LEDs in the

CY3265 evaluation unit use the primary colors red, green, and blue, although any three primary

color LEDs can be used in a design, depending upon the application and the desired color gamut.

Right out of the box, CY3265-RGB Evaluation kit can be used to evaluate and demonstrate EZ-Color

functionality, including color mixing. See the quick start on how to use the kit with the factory installed

firmware.

This guide serves two main purposes:

1. Chapter 1. Introduction‚ on page 5 discusses kit contents, installation instructions, and MiniProg.

2. Chapter 2. Application Guide‚ on page 9 discusses the Intelligent Lighting Control application. 

3. Chapter 3. Color Accuracy‚ on page 17 discusses the Color Accuracy, Primary Color Coordi-

nates, and Building RGB Firmware.

1.2 Install Software

1.2.1 Install the CY3265-RGB Kit Software

1. Insert the CY3265-RGB Kit CD.

2. Open Intelligent Lighting Control.msi.

3. Follow the Setup Wizard instructions.

1.2.2 Install the Latest Version of PSoC Programmer

To ensure you have the latest version of PSoC Programmer:

1. Launch PSoC Programmer.

2. Select Help → About PSoC Programmer.

3. Note the version number and click OK.

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT

EYE DAMAGE!

Do not look at the LEDs if they are not covered by the protective

enclosure. The LEDs illuminate at a very high intensity and can

cause permanent eye damage if they are viewed without the

protective enclosure.
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4. Click Check for Updates. PSoC Programmer launches your web browser and opens the PSoC

Programmer web site.

5. Compare the PSoC Programmer version number you noted in Step 3. to the latest version avail-

able on the web site. If the version on the web site is newer, click Download, and install the new-

est version.

1.2.3 Install the PSoC MiniProg

1. Ensure all content on the Tools CD is installed. 

2. Plug the MiniProg into your PC via the USB cable. If this is the first time you have connected the

PSoC MiniProg, the Windows Found New Hardware Wizard opens. If the Windows Found New

Hardware Wizard does not open, then the PSoC MiniProg software is already installed and you

do not need to continue with these instructions.

3. Select the No, not this time option button, and click Next.

4. Select the Install from a list or specific location (Advanced) option button and click Next.

5. Select the Don't search. I will choose the driver to install option button, and click Next.

6. Select the USB Mini Programmer (x.x.x.x) driver and click Next.

7. When prompted that the USB Mini Programmer (x.x.x.x) software has not passed Windows

Logo Testing, click Continue Anyway.

8. When Windows has completed the installation, click Finish.

http://www.cypress.com/design/SD1062
http://www.cypress.com/design/SD1062
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1.3 RGB Unit Layout

1.3.1 The On/Off Button

The CY3265-RGB evaluation hardware has two buttons and a liquid crystal display. These allow the

unit to be demonstrated without using a personal computer to control the unit. When held properly

for use, the liquid crystal display is on the top right. When held in this orientation, the right-most but-

ton alternately turns the high brightness LEDs on and off. The default setting when first applying

power to the unit is ON; pressing this right-most button illuminates the LEDs.

1.3.2 The Color Selection Button

When the unit is held as described in the previous section, the left-most button along the bottom

edge cycles between seven preset colors. The initial color is white (all three LEDs are illuminated at

high intensity). Pressing this button changes to the next color of the seven preset colors. The color

sequence cycles through white, red, green, blue, yellow, magenta and cyan.

Note If the unit has been controlled from a personal computer using the USB interface, the color dis-

played upon powering the unit and pressing the On/Off button is the last color setting selected when

using the monitor application. The unit displays ‘white’ even though it has never been connected to a

personal computer, or the last color selected could not be displayed at the selected intensity, the

LEDs do not illuminate (an impossible color and intensity combination has been selected). Pressing

the color selection button, selects a valid color for display from the seven preset colors and the LEDs

illuminate with that color.

1.3.3 The Liquid Crystal Display

The liquid crystal display displays the currently selected color using CIE 1931 color coordinates. The

values displayed represent the CIE x, y coordinates for the currently selected color, whether chosen

from the seven preset colors or selected from the Intelligent Lighting Control application (when using

the factory installed firmware). 

If the LEDs are illuminated, an asterisk (‘*’) is displayed on the left end of the top row of the liquid

crystal display (this is useful if the last color selected cannot be displayed with the given LEDs,

resulting in the LEDs being dark).

Figure 1-1.  RGB Unit
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1.4 Document Revision History 

1.5 Documentation Conventions 

Table 1-1.  Revision History

Revision
PDF Creation 

Date

Origin of 

Change
Description of Change

** 6/27/08 AESA New Guide

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:

C:\...cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:

[Enter] or [Ctrl] [C]

File → Open
Represents menu paths:

File → Open → New Project

Bold
Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes Cautions or unique functionality of the product.
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2. Application Guide

2.1 Installation

2.1.1 Installation Requirements

To use the application included with the CY3265 RGB evaluation unit, a personal computer running

Windows Vista or Windows XP is required. The application runs under 32-bit XP or 32-bit Vista. The

computer must have the minimum amount of memory required to run the desired version of Win-

dows, and at least one megabyte of available disk storage. In addition, one available USB port is

needed to connect the evaluation unit to the computer, using an A to mini-B USB cable.

2.1.2 Installing the Application

The Intelligent Lighting Control application is included on the kit CD. To install the application, do the

following:

1. Open the CD and click on the Intelligent Lighting Control.msi file. The application, along with a 

required .dll file (and .NET Framework 2.0, if it is not already installed), installs. 

2. The Intelligent Lighting Control application and associated .dll file installs into the location 

C:\Program Files\Cypress Microsystems\Intelligent Color Control on your 

computer’s default disk, usually drive C:.

2.1.3 Uninstalling the Application

To uninstall the application, do the following:

1. Run the Install program again and click on the Remove Intelligent Lighting Control button.

2. Click on the Finish button at the bottom right of the setup window.

2.2 Introduction

The purpose of the CY3265-RGB evaluation unit is to illustrate the ability of Cypress’s EZ-Color™

HB-LED Controller powered by PrISM™ technology to control three primary, high power LEDs, cre-

ating accurate mixed-color output. The three LEDs in the CY3265-RGB evaluation unit consist of pri-

mary colors red, green, and blue. The application described controls the RGB evaluation unit

through a USB port on a personal computer that is running either the Windows Vista (32-bit) or Win-

dows XP (32-bit) operating system. The application’s startup display, with a board attached and

operating is shown in Figure 2-1 on page 10.
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Figure 2-1.   Intelligent Lighting Control Application Window
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2.3 Representing Colors

The application has two modes of control: a CIE Color Selection Mode and Direct LED Control

Mode. These two modes are selected using tabs displayed on the upper left edge of the application

window. The CIE Color Selection Mode is the active display when the application is started and is

intended to be the most common mode used to control the RGB unit. 

The colors that can be mixed are determined by the choice of LEDs used in the unit. The colors pro-

duced by individual LEDs are referred to as primary colors. All other colors are created by mixing

these primary colors. Mixed colors appear the same to the eye as if produced by an LED with that

color as its primary color. The interior portion of the triangle displayed on the color chart represents

the range of colors that can be mixed by the LEDs in the unit. The range of colors that can be mixed

when using a given set of primary LEDs is called the color gamut for those LEDs. Once the primary

LED colors are determined, as they are in the evaluation unit, the color gamut is defined by those

choices. Thus, the triangle displayed by the application defines the color gamut for the unit. Colors

outside of the color gamut cannot be represented by the given LEDs and the user cannot select col-

ors outside the color gamut1.

The CIE Color Mix Mode displays the 1931 CIE Color chart. This chart represents the range of col-

ors visible to the human eye. Clicking anywhere within the color gamut triangle places a dot at the

selected point. The corresponding CIE coordinates for that color coordinate are transmitted to the

RGB unit, where the selected color is displayed by adjusting the three LEDs to brightness levels that

create the specified mixed color. The resulting coordinates are displayed in the CIE Coordinates

panel on the upper right portion of the display. The CIE 1931 x, y coordinates are displayed in the

upper two coordinate fields and the u’, v’ coordinates are displayed in the lower two fields (see

Figure 2-2). An alternative to selecting a color by clicking in the color chart is to enter coordinates

into these fields. The user can enter a color point in x, y coordinates, u’, v’ coordinates, or any com-

bination of the two coordinate systems.

Figure 2-2.  The CIE Color Coordinate Fields

The Direct LED Control Mode is an alternative to specifying colors using CIE coordinates (Figure 2-3

on page 12). This mode displays three slider controls, one for each LED on the board. Moving a

slider from bottom to top causes the corresponding LED to light from zero to one-hundred percent of

its maximum rated flux. When the direct LED control mode is enabled, all controls that relate to mix-

ing colors are disabled, including the Requested Luminous Flux slider that sets the total flux of a

given mixed color: these controls have no meaning when setting the individual LED flux levels

manually.

1. The triangle is an approximate gamut boundary. For points adjacent to the triangle edges, especially close to the LED coordinates (that is,
the corners), it is possible to select a point that falls outside of the color gamut. For any coordinate outside of the gamut, the LEDs turn off. 
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Figure 2-3.  Direct LED Control Panel

The application can also limit color choices to those that are produced by a black body radiator. A

black body radiator is a theoretical, color-neutral object defined by Plank’s Law. A black body radia-

tor glows (radiates energy) at different colors as it is heated. When enabled, the black body curve is

displayed on the CIE color chart (see Figure 2-4 on page 13). This curve marks the colors that corre-

spond to the color of a black body radiator over a range of temperatures in Kelvin. The user selects

the color temperature value by sliding the color temperature slider (see Figure 2-5 on page 13).

Color temperature (more generally, correlated color temperature) is a common way that the color of

light is specified. Disabling the color temperature control removes the black body curve from the

color chart, disables the color temperature slider, and enables the controls used to specify mixed col-

ors using the CIE color chart.
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Figure 2-4.  The Intelligent Lighting Control Application in Color Temperature Mode

Figure 2-5.  Color Temperature Slider Control

In addition to displaying colors, the application allows the user to turn the LEDs On or Off. The state

of the LEDs (‘on’ or ‘off’) is based on a closed loop between the application and the RGB unit that

determines the actual on/off state of the LEDs. The On/Off buttons are displayed on the bottom right

portion of the application’s window (Figure 2-6 on page 14). When the LEDs are off, the LEDs On

button is enabled. Clicking on this button turns the LEDs on. If the LEDs are on, the Off button is

enabled and clicking on this button turns the LEDs off. Regardless of the setting when the applica-

tion is not connected to a board, the buttons change to show the actual state of the LEDs when the

board is attached.
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Figure 2-6.  LED On/Off Controls

2.4 Status Display

Below the tabbed window is a status window, which shows the current status of the connection

between the application and the RGB unit, and any error messages. If an error or change of status

occurs, a message appears describing the event. The message “I2C Bridge device found – Version

1.0” is displayed in the status window in Figure 2-7. The message appears for approximately five

seconds and is then cleared from the status window.

Figure 2-7.  Application Displaying a Status Message
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2.5 Running the Application with no RGB Unit Attached

If no RGB unit is detected, for whatever reason, the application automatically starts without any

gamut (Figure 2-8). If the RGB unit is detected, the detection of the unit is indicated in the status win-

dow. When the application is run without a RGB unit attached, any point on the CIE color chart can

be selected.

Figure 2-8.  Application Without an Attached RGB Unit
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2.6 LED Luminous Flux

The luminous flux of the mixed color output can be varied using the Requested Luminous Flux slider

located on the right side of the application window (Figure 2-9 on page 16). The maximum total flux

produced by the LEDs varies, depending upon the chosen color. For example, a neutral white can

be set to a higher total flux than any of the three primary colors alone, as the color white is repre-

sented by a sum of the light output of each of the LEDs. The saturation point (the point of maximum

total flux) differs for different colors. Moving the slider to a requested flux higher than the saturation

point for a given color has no effect upon the light output of the LEDs as they remain at that mixed

color's saturation point. Note that this slider determines the requested luminous flux. This requested

value is usually derated by the color mixing firmware on the RGB unit. This is required to perform

temperature compensation, keeping the requested color as accurate as possible.

Figure 2-9.  Requested Luminous Flux Slider Control

2.7 Dynamic Update

The RGB unit has two buttons that allow the board to be demonstrated without using the RGB unit

control application (see RGB Unit Layout on page 7). The button labeled ON/OFF on the RGB unit

turns the LEDs (alternately) on and off. The button labeled COLOR is used to cycle between seven

preset colors. At any time, the user can use the buttons on the unit to control the evaluation unit. The

application checks the current state of the RGB unit once every second and automatically updates to

accurately reflect the present state of the unit. If the user selects the Direct LED Control tab, the

LEDs on the RGB unit automatically turn off. 

2.8 Shutting Down the Application

The application is closed by clicking on the Windows close box icon ‘x’ in the upper right corner of

the application window. 
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3. Color Accuracy

The colors displayed by the CY3265 RGB unit are based upon average values for the variety of

LEDs available for this unit. Different manufacturer’s LEDs vary from one another in their color and

different manufacturing cycles of a given manufacturer’s LED also vary. Due to this, the colors dis-

played may not be accurate for the particular LEDs on your device, although every effort has been

made to determine reasonable average values for the various LEDs used, you may notice accuracy

variations, especially with coordinates generally corresponding to white light.

The high accuracy color capability of your RGB unit requires the unit to be calibrated. Calibration

requires you to determine the precise color coordinates for each of the three LEDs used on your

LED board. Such color coordinates can be obtained by using a precision color meter, such as the

Minolta Chroma Meter CL-200. Less accurate, subjective color adjustment can be obtained by trial

and error. The calibration values are defined in the RGB firmware. The procedures for accomplishing

this is described in the following section.

3.1 Finding Calibration Values

To determine calibration values, the Intelligent Lighting Control application should be used to illumi-

nate each LED at it's maximum intensity before obtaining a calibration reading.  The best way to

accomplish this is to attach the CY3265-RGB unit to a PC that has the Intelligent Lighting Control

application installed.  Start the application and select the Direct LED Control tab.  Slide the Red LED

slider to 100% and make sure the Green and Blue sliders are set at 0%.  Using a color meter, take a

reading from the illuminated color cube.  To ensure greatest accuracy, make sure there are no other

light sources visible to the light meter when obtaining the reading.  Record the luminosity and X, Y

CIE 1931 coordinate values.

Set the Red slider to 0%, the Green slider to 100% and the Blue slider to 0%.  Repeat the meter

reading and record the resulting readings for the Green LED.  Finally, repeat the procedure with the

Blue LED set to 100% and the Red and Green set to 0%.  You should have recorded nine values,

three for Red, three for Green and three for Blue.  These reading will be configured into the firmware

as described in the next section.

WARNING: HIGH BRIGHTNESS LEDs CAN CAUSE PERMANENT

EYE DAMAGE! 

Do not look at the LEDs if they are not covered by the protective

enclosure. The LEDs illuminate at a very high intensity and can

cause permanent eye damage if they are viewed without the

protective enclosure.
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3.2 Setting Primary Color Coordinates

Three parameters are defined for each of the three LEDs. These nine parameters are defined in the

header file LED_Calibration.h. The three parameters, in the order they are defined, are maxi-

mum lumens, CIE X base color coordinate and CIE Y base color coordinate. The maximum lumens

designates the maximum light output for the given LED. This value is a positive integer with the

range 8 to 1,856. The X and Y coordinates are the CIE 1931 standard coordinates that designate the

color of light generated by the LED.   The settings are defined for the three LEDs assuming primary

LED colors of ‘red,’ ‘green’ and ‘blue,’ although any three LED colors could be used, depending upon

the desired color gamut. Coordinate values are represented as four-digit integers that are interpreted

as four-digit fixed-point fractional values ranging from 0.0000 to 0.9999 in both the X and Y dimen-

sion. Thus, for example, the fractional X value of 0.7011 is defined with the integer value 7011.

The header is reproduced below:

//---------------------------------------------------------------------

//---------------------------------------------------------------------

//  FILENAME: LED_Calibration.h

//   Version: 1.2, Updated on 2008/04/02 at 13:00:00

//  Generated by Ben Kropf

//

//  File name changed to 'LED_Calibration.h' 2008/06/06

//

//  DESCRIPTION: Contains all of the defines that are required in

//  for defined labels in the main program. This is compatible with

//  firmware that uses fixed-point math instead of floating point math.

//  This necessitates all of the defines in this file to integers

//  rather than decimal numbers.

//

//  Update 1.2: Removed unused defines and product-specific 

//  parameters.

//               

//---------------------------------------------------------------------

//  Copyright (c) Cypress Semiconductor 2007. All Rights Reserved.

//---------------------------------------------------------------------

//---------------------------------------------------------------------

// Parameters for Red LED

    #define    R_MAX_LUMENS         ( 1856 )  //7.25 * 2^8

    #define    R_BASE_COLOR_X       ( 7011 )

    #define    R_BASE_COLOR_Y       ( 2982 )

// Parameters for Green LED

    #define    G_MAX_LUMENS         ( 1856 )  //7.25 * 2^8

    #define    G_BASE_COLOR_X       ( 2003 )

    #define    G_BASE_COLOR_Y       ( 7181 )

// Parameters for Blue LED

    #define    B_MAX_LUMENS         ( 1856 )  //7.25 * 2^8

    #define    B_BASE_COLOR_X       ( 1263 )

    #define    B_BASE_COLOR_Y       (  817 )

//End of file "LED_Calibration.h"
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3.3 Building a new RGB firmware image

The procedure for building the new color mix firmware differs, depending upon which version of

PSoC Designer is being used. Where different, the following description details the necessary steps

for both PSoC Designer 4.4 and PSoC Designer 5.0.

It is assumed that the reader is familiar with the opening and editing source files using one of the ver-

sions of PSoC Designer described here. If not, please refer to documentation about PSoC Designer

available on http://www.cypress.com.

3.3.1 Saving the File

After editing the file LED_Calibration.h to define the desired LED parameters, save the file in

one of two ways: either click on the File label in the menu bar and move the mouse cursor to high-

light and then click on Save, or click on the  icon on the Designer IDE toolbar. This step is the

same for both versions of PSoC Designer.

3.3.2 Rebuilding your firmware

In PSoC Designer you can rebuild the firmware in one of two ways: either click on the Build label in

the menu bar and move the mouse cursor to highlight and then click on the Build option listed. Alter-

natively, simply press the [F6] key ([F7] for PSoC Designer 4.4). The third option is to click on the

 icon on the toolbar (or the  icon for PSoC Designer 4.4).

3.3.3 Loading your new firmware

Make sure the MiniProg is attached to your PC using a USB cable before performing this step. Fur-

ther, connect the MiniProg to the ISSP header on your RGB unit. To access this header you have to

remove the top cover of the RGB unit’s enclosure by first removing the three screws holding the

cover on. Make sure PSoC Programmer has the focus (that is, the active program) before proceed-

ing.

3.3.4 Using PSoC Designer 4.4

You can load your new firmware directly from your PSoC Designer session in one of two ways:

Select the Tools option from the menubar. Move your mouse cursor over the Program Part option

and click. Alternatively, click on the  icon on the toolbar. With either option, Designer starts the

application PSoC Programmer. The correct programming options should automatically be selected

by PSoC Designer. You can verify this by examining the four status boxes in the bottom right portion

of the PSoC Programmer window. If all of these boxes are green, your part is ready to be pro-

grammed.    On the toolbar of PSoC Programmer, click on the button labeled Program. Alternatively,

click on the label Programming on the menu bar and then select and click on the label Program (or

simply press the [F5] key).

After selecting the program option, the status of the firmware download is displayed in the status

window of PSoC Programmer. Programming proceeds followed by a verification that the firmware

has been loaded correctly. Finally, a checksum is performed on the downloaded firmware. When the

process completes without error, PSoC Programmer issues a Programming Succeeded message,

followed by the completion time. You have successfully programmed your RGB unit. If this proce-

dure fails for any reason, refer to the documentation available for PSoC Programmer on the web site

http://cypress.com for a complete description about using PSoC Programmer. 
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3.3.5 Using PSoC Designer 5.0

To load your firmware using PSoC Designer 5.0 click on the Program label in the menu bar. Move

your mouse cursor to the PSoC Programmer selection and click. PSoC programmer starts and

works in the same fashion described above for PSoC Designer 4.4. At the time of this writing, there

is no default toolbar icon available in Designer 5.0.
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